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Abstract

This report is a supplement to the original RADTRAD user’s manual.  It describes
modifications that have been made to the graphical user interface (GUI) and to the
numerical engine used to solve coupled ordinary differential equations. Other
improvements to the code are also described.

A major portion of this report is a replacement to the original user’s guide, which
describes how to install and use the current version (3.01). The GUI is now based on
Visual Basic and operates quite differently than the GUI used in earlier code versions.
The original numerical engine, which was based on the Laplace transform technique,
has also been replaced with a new method that is both faster and more accurate. One
new test case has been added to the standard test suite. Updated results for the entire
suite of test problems are presented. Finally, a description of the new input format is
provided.
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Introduction

The potential radiological consequences of a postulated nuclear power reactor accident
depend on the timing, quantity, physical form (i.e., vapor or aerosol), and chemical
speciation of the radioactive material released into the environment. The RADionuclide
Transport, Removal, And Dose (RADTRAD) code is designed to estimate doses at
offsite locations, e.g., the exclusion area boundary (EAB) and low population zone
(LPZ), and in the control room of a nuclear power plant.

RADTRAD is designed to model two types of releases from the reactor coolant system
into the containment. Instantaneous releases are specified in “Calculation of Distance
Factors for Power and Test Reactor Sites” (DiNunno et al., 1962) and in Regulatory
Guides 1.3 and 1.4 (USNRC, 1974a, 1974b). More protracted and realistic source
terms are specified for boiling water reactors (BWRs) and pressurized water reactors
(PWRs) in “Accident Source Terms for Light Water Nuclear Power Plants” (Soffer et al.,
1995). These instantaneous and protracted releases are represented through input files
that are included with RADTRAD. Other source terms can be modeled by modifying
one of the standard input files.

RADTRAD includes models for a variety of processes that can attenuate and/or
transport radionuclides. It can model sprays and natural deposition that reduce the
quantity of radionuclides suspended in the containment or other compartments. It can
model the flow of radionuclides between compartments within a building, from buildings
into the environment, and from the environment into a control room. These flows can be
through filters, piping, or simply due to air leakage. The models for flow-through piping
can optionally account for aerosol deposition and iodine chemisorption. RADTRAD can
also model radioactive decay and in-growth of daughters. The code contains over 25
model and table options. It is anticipated that RADTRAD will be used to estimate the
effect of facility modifications and alternative accident management strategies on
release of predicted source terms to the environment. These estimates may be used to
support probabilistic risk assessment (PRA) and licensing studies.

This document is a supplement to the original RADTRAD user’s manual (Humphreys et
al., 1998).  It describes recent modifications to the code that have resulted in version
3.01. These include a replacement of the graphical user interface (GUI), a replacement
of the numerical engine used to solve systems of linear ordinary differential equations
(ODEs), and the capability to model multiple source-term compartments. The new
computational engine is both faster and more accurate than the original one, which
employed the Laplace transform method.

This document is organized into four chapters. The first chapter is a user’s guide that
describes the process of installing version 3.01 and the new GUI. The second chapter
describes the main RADTRAD input file, which contains the plant and scenario
information needed to specify an accident sequence. The third chapter briefly describes
the new computational engine. Finally, the fourth chapter describes an additional test
case that has been added to the standard RADTRAD test suite. It also includes
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updated results for the entire test suite. Some of the results have changed slightly
because of the increased accuracy of the new numerical engine.
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1. RADTRAD User’s Guide

The RADTRAD user’s guide consists of two sections. The first section provides
instructions for installing RADTRAD and running the standard test suite. The second
section describes the graphical user interface (GUI). This chapter should be useful for
both novice and experienced RADTRAD users.

1.1 Getting Started

This section covers the installation of the RADTRAD 3.01 code on your computer. The
code is supplied on a CD. Installation is automated and should be straightforward.

1.1.1 Installation
RADTRAD 3.01 and subsequent versions are intended to run under Windows 95/98
and Windows NT 4.0. Installation requires about 20 MB of disk space and a CD-ROM
drive. RADTRAD 3.01 works best with a 17-inch or larger monitor set to a resolution of
at least 1024x768 pixels.

To install RADTRAD, open the folder corresponding to your CD-ROM drive, then
double click on setup.exe. Other applications should be closed. The default installation
path is C:\Program Files\Radtrad, but the user can choose any path. RADTRAD may
also be installed using Control Panel->Add/Remove Programs.

Once installation is complete, the acceptance cases and the default files are available
in two forms. The Accept folder contains the acceptance test files with write permission.
The Accept/Defaults folder contains nuclide inventory (NIF), release fraction and timing
(RFT), and dose conversion factor files (INP) with write permission. The Accept.zip file
contains read-only copies of the acceptance cases and defaults files. The Defaults.zip
file contains read-only copies of the defaults files, i.e., NIF, RFT, and INP files.

RADTRAD can be uninstalled by using Control Panel->Add/Remove Programs.

1.1.2 Contents of the RADTRAD Installation Folder
After installing RADTRAD, a main installation folder should have been generated. By
default, the main folder will be named \Program Files\Radtrad, but may be given a
different name during installation, as described above. The following table describes the
structure of the installation folder and each of the files that it contains. Some restrictions
on the locations of files are also described in the table.
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Folders Accept Acceptance cases (.psf extension). These files are
simple concatenations of older .pmf and .sdf
acceptance case files, which are retained in the
Accept/SaveAccept folder.

Accept/Defaults Three defaults files are needed to run RADTRAD: the
nuclide inventory file (.nif extension), the release
fraction and timing file (.rft extension), and the dose
conversion factors file (.inp extension). These files
are in the Defaults folder.

Accept/SaveAccept The acceptance case input files in the older format,
with extensions of .pmf and .sdf

Bitmaps Graphical files necessary for vbradtrad.exe. This
folder must not be moved or deleted.

Files Accept.zip A zip file that contains the same files that are in the
Accept folder, but with read-only permission. The files
can be extracted with Winzip or Pkzip.

Defaults.zip A zip file containing the same files that are in the
Defaults folder, but with read-only permission. The
files can be extracted with Winzip or Pkzip.

Radtrad.dll The code called to launch a calculation. This file must
remain in the same folder as vbradtrad.exe.

Radtrad.ini Text file used to initialize the visual interface to the
current RADTRAD version. It must remain in the
same folder as vbradtrad.exe.

Radtrad301.pdf An electronic copy, in Acrobat format, of this
document

St5unst.log A file required to uninstall RADTRAD using
Add/Remove Programs. If it is deleted, uninstall by
simply deleting the installation folder. However, doing
this will leave the name Radtrad in the Programs
menu. To avoid this, reinstall RADTRAD to restore
St5unst.log and then remove RADTRAD with
Add/Remove Programs.

Vbradtrad.DEP Utility file
Vbradtrad.exe The starting point of the application. Double click on

this filename to run the GUI for developing
RADTRAD input (.psf files) and to launch a
calculation.

1.1.3 Running the RADTRAD Acceptance Cases
To run the acceptance test cases, use the following procedure:

1. Start RADTRAD either from the Programs menu or by double-clicking
vbradtrad.exe in C:\Program Files\Radtrad or other installation path.

2. Click Open Radtrad input in the File menu or click the  icon on the toolbar. In the
resulting dialog form, locate the Accept directory and click Open. Choose an input
file from the PSF files displayed (Test1.psf, Test10.psf, etc.). After the file is read
and closed, its name and a derived unique filename for RADTRAD output are
displayed in the status bars at the bottom of the main RADTRAD form.

3. Recommended: Set full paths for the defaults files as follows: Open the Source
Term form by clicking on the button labeled Source Term and DCF... For each of the
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required defaults files (Nuclide Inventory, Release Fractions and Timing, and Dose
Conversion Factors), click on the appropriate folder tab and then on the Browse
button to select the same reference file named in the textbox. This will change the
name in the textbox (which was read from the acceptance case test file) to a full
path with drive letter. When the user clicks Calculate (step 5), there is a prompt to
save input. Changing these paths will only take effect if the file is saved.

4. To save input, click Save RADTRAD Input in the File menu or click the  icon in the
toolbar. If the file is read-only, the user will have to rename the file to be saved.
Existing files with write permission will generate a warning and a choice to replace
the existing file or to rename the file about to be saved. It is important to realize that
the RADTRAD calculation will use input from the file on disk, not from the data on
the forms.

5. Optional: Click the button labeled Control Calc Options to add a title or change the
output filename. This button also allows supplemental time steps to be entered, as
described in Chapter 2.

6. Click the button labeled Calculate to launch a RADTRAD calculation with the current
input file named on the status bar. Save input in 3.01 format if prompted. This also
saves the default file paths if they were updated, as recommended in step 3. If the
file is not successfully saved in 3.01 format before a calculation is launched, the
following error message will be displayed: “Calculation was cancelled, probably due
to file format. Save in current format and try again.” The output will be displayed in a
simple text editor a few seconds after the calculation is done.

1.1.4 Differences in RADTRAD 3.0.1 and Previous Versions
RADTRAD input was formerly contained in two files: the plant model file with extension
.pmf and the scenario description file with extension .sdf. These two files are now
merged into one RADTRAD input file with a .psf extension. The acceptance cases are
in PSF format in the Accept directory; files with the old format are retained in the
Accept\SaveAccept folder. A PSF file can be constructed by concatenating a PMF and
an SDF file. However, a file created in this fashion must be saved in 3.01 format before
a calculation can launched, as explained in the following paragraph.

RADTRAD 3.01 allows multiple source term compartments. Any compartment of type
Other (i.e., not Control Room or Environment) may be assigned a source term fraction.
There is a change in input format to handle this capability. The RADTRAD interface will
read either a single source-term format (concatenations of PMF and SDF files) or a
multiple source-term format. It will always write files in multiple source-term format.

RADTRAD version 3.01 (and future versions) writes a version stamp at the top of the
PSF file. This stamp allows RADTRAD to automatically recognize and read multiple
formats. Thus, future modifications to the format of PSF files should be transparent to
the user. The intention of the RADTRAD developers is to maintain a backward
compatibility with previous versions.
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1.2 The Graphical User Interface (GUI)

The GUI used in version 3.01 (and subsequent versions) is entirely different than the
one used in previous versions (2.xx). The most basic difference is that the GUI in 3.01
uses a Visual Basic interface that runs under Windows 95/98 or Windows NT while the
GUI used in versions 2.xx was developed using High Screen Pro and ran under DOS.
The user should find the new interface much more flexible and easier to navigate. Basic
instructions for using the new GUI are included in the following subsections.

1.2.1 
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The Main Form
Starting vbradtrad.exe brings up the main form titled RADTRAD 3.01 (or other current
version number) shown on the bottom of the preceding page. On it are three
combination boxes, one with a dropdown menu of compartment names, the next with a
dropdown menu of transfer pathway names, and the third with a dropdown menu of
dose locations. If an input file has not been opened, all the names will appear as
Unused, as shown here.  Selecting any of these names will open the appropriate form
for entering plant and scenario data. The combination boxes are arranged in the order
in which data are normally entered.

The Menu

File->Open Radtrad input opens a PSF file and places all data contained in the file on
the current forms. This action makes the input data available for modification or for
launching a calculation.

File->Save Radtrad input saves a PSF file from the data on the current forms. This
must be done before launching a RADTRAD calculation in order for any modifications
to take effect. This is because the launched calculation reads input data from the file on
the disk, not from the data displayed on the forms.

File->Read or Print Radtrad output starts a simple text editor. Output files (or other files)
can be viewed, edited, and printed from this editor.

File->Exit is the formal RADTRAD exit. It releases all memory used by RADTRAD.
Another way to exit from RADTRAD is to click the X button at the upper right corner of
the control bar.

Edit->Clear all input reinitializes all compartment, pathway, dose location, filename, and
model data. This same function is automatically performed just before a PSF file is
opened.

The Toolbar
The toolbar has already been described in Subsection 1.1.3. The  icon is equivalent
to File->Open Radtrad input. The  icon is equivalent to File->Save Radtrad input. The

 icon starts the text editor.

The Done Checkboxes
Use of these checkboxes is entirely optional. Clicking on a Done checkbox brings up a
prompt to save input, but input can also be saved from the menu, the toolbar, or at the
prompt just before a RADTRAD calculation is launched. The purpose of these boxes is
to help the user keep track of what portions of data entry have been completed. A
checked Done box is not preserved when a saved PSF file is reopened–-RADTRAD
always starts with these boxes unchecked.
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1.2.2 The Compartment Form
Required input data in the Compartments form are Compartment Name other than
Unused, Compartment Type, and Volume (unless Type is 3-Environment).  Select the
Compartment Type from the dropdown list and enter the other items. Any data entered
onto the form for a compartment of type 0-Unused will not be saved to a file.

The frame labeled Compartment Features is a checklist of possible features (sprays,
recirculating filters, natural deposition, or overlying pool). When a feature is checked,
the corresponding tabbed folder is brought to the front. The user then selects the
appropriate model with the radio buttons, enters its required data, and enters any
remaining user-defined coefficients. The appropriate command buttons for each model
are enabled when it is chosen. Clicking these command buttons will bring up a data
form somewhat like a spreadsheet for data entry. The data forms are described in
subsequent subsections.

Some of the buttons on the front tabbed folder (here Sprays) are enabled even though
Sprays is not checked. The user could enter data under the Sprays tabbed folder, but it
would not be saved unless the user checks the Sprays checkbox.

The Source Term Fraction entry designates the fraction of the overall source term that
should be placed in the current compartment. For example, this value should be 1 if the
current volume is to receive the entire source term; it should be 0 for all other
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compartments. If the source term is to be split evenly between two compartments, then
the Source Term Fraction should be set to 0.5 for those two compartments and to 0 for
all others.

The Overlying Pool feature becomes available if Compartment Type 3-Other is
selected. The Overlying Pool feature is effective only during the ex-vessel phase of
severe accidents.

The OK and Reset Commands
Most forms in the RADTRAD 3.01 interface have a pair of buttons in the upper right
corner, OK and Reset. Clicking OK saves the data currently on the form. The word
save, as it is used here, does not imply that the data will be saved to a file; only that it
will be retained in memory so that if the user later returns to the form, the same data will
reappear. (Saving data to a file is discussed in Subsection 1.2.1.) Before data are
saved, they are edited (i.e., checked to see if they pass certain requirements, such as
being a non-negative number). If they pass the edits, they will be saved for that
compartment, pathway, or dose location until modified and saved again or until a new
input file is loaded. If there are errors, they will be pointed out to the user during the
editing process.

Clicking Reset restores the previously saved data. This action bypasses the edit
process on the assumption that the previously saved data had already passed the
edits. The OK command closes the form, but Reset does not. After clicking Reset, click
OK to close the form, or use the Previous or Next commands described below.

On the pathway and dose location forms, clicking Reset also updates the dropdown
menus of compartment names in case new compartments have been created since the
form was first displayed. Be aware, however, that the data on the form that were last
saved will also be restored and any unsaved changes will be lost.

The Previous and Next Commands
Most data entry is controlled from the three forms labeled Compartments, Transfer
Pathways, and Dose Locations. These forms have under their titles a horizontal
scrollbar and the words Previous and Next at either end, as shown for the
Compartments form.  Click Previous to go to the previous compartment, pathway, or
dose location. The Previous command is ignored when the current entry is the first one.
Click Next to go to the next compartment, pathway, or dose location. The Next
command is ignored at the maximum values of 10 compartments, 25 pathways, or 10
dose locations. Another way to move among compartments, pathways, and dose
locations is to drag the horizontal scrollbar using the left button of the mouse.

Any data that have been entered on a form are automatically saved when another
compartment is entered. Thus, the user must click Reset before moving to another
compartment if he does not wish to save the data that he just entered. As with the OK
button, edits are performed on the current data before moving to the next compartment.
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If any errors in the data are found during the edit process, they are highlighted and
must be corrected before proceeding.

1.2.3 The Pathway Form
Required inputs for each active pathway are From Compartment, To Compartment,
Pathway Name, and Transfer Mechanism. Pathways that do not have Yes selected
under Active Pathway will not be saved to a file. Active Pathway is set to Yes by default
when a Transfer Mechanism is selected. Only one Transfer Mechanism can be
selected for a transfer pathway. When the user indicates a transfer mechanism, the
corresponding tabbed folder is brought to the front, where user-defined coefficients are
entered or a model is chosen and its requirements are entered. Requirements for
Transfer Mechanism data are described later in this chapter.
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1.2.4 The Dose Location Form
Required dose-location inputs are Name other than Unused, In Compartment, χ/Q, and
Breathing Rate (BR). A control room compartment also requires Occupancy Factors to
be specified. The user may select appropriate defaults in BR Defaults by clicking on
EAB or LPZ or Control Room. Dose Locations with Unused as part of their name (case
insensitive) will not be saved to a file.

Tables with a time value in hours followed by one or more values are used throughout
the RADTRAD interface. The rules for these tables are consistent. The first time value
is always 0.0000 and cannot be modified. Tabulated values are treated as piecewise
constants. Thus, the value to the right of 0.0000 is in effect until the second value of
time is reached. At that time, the value to the right of this time takes effect. There is no
interpolation of the tabular values. If only one value is entered at time zero, it remains in
effect throughout the calculation. If the second time in the table is the final time of the
calculation, often 720 hours, then the value to the right of this time is inconsequential.
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1.2.5 The Source Term and Dose Conversion Factors Form
Required inputs on this form are NIF File (nuclide inventory file), RFT File (release
fraction and timing file), and DCF File (dose conversion factor file), Decay and Daughter
Products option, and Iodine Chemical Fractions. Plant Power must also be set in order
to perform a nontrivial calculation.

Clicking the Default PWR, Default BWR, or Default TID buttons will place an entry into
the NIF File box. The default file names will work correctly when a Defaults folder is in
the same directory as the input PSF file. If it is not, the user should select the User
Inventory option and then use the browse function to locate the appropriate file. The
process is similar for each of the tabbed folders, i.e., Release Fraction and Timing and
Dose Conversion Factors.

While not necessary, it is recommended that the user verify the full path of the NIF,
RFT, and INP files by using the Browse button to locate each of these files. Doing so
will cause a full, valid path, beginning with a drive letter, to be appear. If an invalid path
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is saved to the PSF file, then a launched RADTRAD calculation will abruptly terminate
(with no error message) because it cannot find the specified file.

Clicking either TID or 1465 selects the appropriate iodine chemical fractions
documented in the original RADTRAD manual. The user may modify the iodine
chemical fractions manually, but they must always sum to unity.

1.2.6 The Calculation Control Options Form
There is no required input for this form. The optional Case Title allows the user to insert
a short description of the calculation in the input file (PSF file) that is written. This
description is also echoed to the output file generated when a RADTRAD calculation is
launched. A unique Output File name is chosen as the default when an input file is
opened, but it can be modified on this form. The default nomenclature for the output file
name is to use an extension of .Ox, where x is the smallest nonnegative integer that
does not lead to a conflict with an existing file.
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The Show Results options allow the user to customize the level of RADTRAD output.
Five options can be selected, each adding a level of detail to the output file. If nonzero
Supplemental Time Steps are entered, the time steps will be no larger than the
specified value until the next value of time is reached. Ordinarily, the internal time-step
controls in RADTRAD are adequate to obtain a high level of accuracy so supplemental
time steps need not be specified. However, this option is available so that the user can
check the sensitivity of results to time-step size.

1.2.7 The Text Editor
The editor that pops up automatically at the end of a RADTRAD calculation is shown
here for one of the acceptance test cases (Test10.psf). The end of the file can be
reached by pressing Control-End. The vertical scroll bar can also be used to move up
or down within the displayed file.

Sections may be cut from the file and the shortened file saved, or selected blocks of
text may be copied to the system clipboard for use with other applications. From the
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Edit menu, the user may comma- or tab-separate a selected block of text. This is
convenient for pasting into a spreadsheet from the system clipboard. The user can also
undo the tab and comma operations.

From the text editor, any ASCII text file can be located and edited by using the drive,
folder, and file windows at the right of the text. The text editor can be opened at any
time during a RADTRAD session. To open it, click the button labeled Read Output or
Print or click the  icon on the toolbar.

1.2.8 Data Entry for Compartment Features: Sprays

Removal Coefficients
Acceptance case Test23 is illustrated here. The tabular values are removal coefficients
for aerosol, elemental iodine, and organic iodine in units of fraction per hour.

Edits: Time values must be entered in ascending order. Removal coefficients must be
non-negative numbers.
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Access: On the Compartments form, check the Sprays feature to bring forward the
sprays tabbed folder. Then click the enabled User-Defined Coefficients  button to  pop
up this form.

Powers Aerosol Model
Acceptance case Test24a is illustrated here. This form contains spray flux in cubic feet
per minute per square foot and height of the spray in meters. Other required
parameters are the fraction of the volume that is sprayed and the percentile. Selecting
10% gives a reasonable lower-bound estimate for aerosol removal, 50% gives a mean
value, and 90% gives a reasonable upper bound.

Edits: Time values must be entered in ascending order. Flux, height, and fraction
sprayed must be non-negative.
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Access: On the Compartments form, check the Sprays feature to bring forward the
sprays tabbed folder.  Choose the Powers option.  Click the enabled Powers Aerosol
Model button to pop up this form. Removal coefficients for elemental and organic iodine
can also be entered in the same way as illustrated above for the User-Defined
Coefficients option.

1.2.9 Data Entry for Compartment Features: Recirculating Filters

Filter Efficiencies
Acceptance case Test10 is illustrated here. The data on this form specify filter
efficiencies in units of percent for aerosols, elemental iodine, and organic iodine.

Edits:  Time values must be entered in ascending order. Filter efficiencies must be non-
negative and no larger than 100%.
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Access: On the Compartments form, check the Recirculating Filters feature.  On the
Recirculating Filters tabbed folder, click the enabled Edit Efficiencies button to pop up
this form.

1.2.10 Data Entry for Compartment Features: Natural Deposition

User-Defined Coefficients
Acceptance case Test23 is illustrated here. Values are removal coefficients in units of
fraction per hour.

Edits:  Time values must be entered in ascending order. Removal coefficients must be
non-negative.

Access: On the Compartments form, check the Natural Deposition feature.  Choose the
User-Defined Coefficients option. Click the enabled User-Defined Coefficients button to
pop up this form.
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Henry Aerosol Model
Acceptance case Test5 is illustrated here. Input values are the spray fall height (i.e., the
vertical distance between the spray nozzles and the floor of the containment) in meters
and the aerosol particle density in grams per cubic centimeter.

Edits:  Time values must be entered in ascending order. Fall height and particle density
must be non-negative.

Access: On the Compartments form, check the Natural Deposition feature. Choose
Henry on the Natural Deposition tabbed folder.  Click the enabled Henry Aerosol Model
button to pop up this form.
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Elemental Iodine Removal Coefficients
Acceptance case Test5 is illustrated here. Values are removal rate for elemental iodine
in units of fraction per hour.

Edits:  Time values must be entered in ascending order. Removal Coefficients must be
non-negative.

Access:  On the Compartments form, check the Natural Deposition feature.  On the
Natural Deposition tabbed folder, choose the Henry Aerosol Model option. Click the
enabled Elemental Iodine button to pop up this form.
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Powers Aerosol Model
Acceptance case Test10 is illustrated here. The values reflect the percentile in terms of
probability. Selecting 10% gives a reasonable lower-bound estimate for aerosol
removal, 50% gives a mean value, and 90% gives a reasonable upper-bound estimate.
A reactor and accident type must also be selected. Note that this model was developed
to model aerosol deposition in containment volumes where the surface-to-volume ratio
is relatively small. Applying this model to other types of compartments, i.e., where
surface-to-volume or aspect ratios are substantially different than those of a
containment, is likely to lead to significant errors.

Edits:  None.

Access:  On the Compartments form, check the Natural Deposition feature to bring
forward the Natural Deposition tabbed folder.  Choose the Powers Containment option.
Click the enabled Powers Aerosol Model button to pop up this form.
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Data Entry for Compartment Features: Overlying Pool

User-Defined Decontamination Factors
No acceptance cases use the overlying pool feature. Values are decontamination
factors, which are dimensionless.

Edits: Time values must be entered in ascending order. Decontamination factors must
be 1 or greater.

Access: On the Compartments form, check the Overlying Pool feature. On the
Overlying Pool tabbed folder, choose the User-Defined Coefficients option.  Click the
enabled User-Defined Coefficients button to pop up this form.
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Powers Aerosol Model
No acceptance cases use the overlying pool feature. Input values are percentile in
terms of probability, pool depth in feet, and pool temperature in degrees Fahrenheit.
Selecting 10% gives a reasonable lower-bound estimate for aerosol removal, 50%
gives a mean value, and 90% gives a reasonable upper-bound estimate.

Edits: Time values must be entered in ascending order. Pool Depth must be non-
negative. Pool temperatures must be at least 36°F. Recommended ranges are pool
depths of 1 to 6 feet and pool temperatures of 86 to 212°F.

Access:  On the Compartments form, check the Overlying Pool feature.  On the
Overlying Pool tabbed folder, choose the Powers option. Click on the enabled Powers
Aerosol Model button to pop up this form.

The form for entering Elemental and Organic Iodine decontamination factors is
analogous to the one for User-Defined Decontamination Factors, except that the
aerosol column is omitted.
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1.2.12 Data Entry for Transfer Mechanisms: Piping

User-Specified Removal Coefficients
Acceptance case Test23 is illustrated here. Input values are removal coefficients in
units of fraction per hour.

Edits: Time values must be entered in ascending order. Removal coefficients must be
nonnegative.

Access: On the Pathways form, choose the Piping transfer mechanism.  On the Piping
tabbed folder, choose User-Specified Coefficients.  Then click Edit Removal
Coefficients to pop up this form.
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Brockmann-Bixler Model
Acceptance case Test14b is illustrated here. Input values are flow rates in cubic feet
per minute, gas pressure in the atmosphere, and gas temperature in degrees
Fahrenheit.

Edits: Time values must be entered in ascending order. Flow rate, gas pressure,
volume, inner surface area, and total pipe bend angle must be non-negative. Gas
temperatures must be at least 32 °F.

Access:  On the Pathways form, choose the Piping mechanism. On the Piping tabbed
folder, choose Brockmann-Bixler.  Click Edit Removal Coefficients to pop up this form.
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1.2.13 Data Entry for Transfer Mechanisms: Filter

Filter Efficiencies
Acceptance case Test24a is illustrated here. Input values are flow rates in cubic feet
per minute and filter efficiencies in percent.

Edits: Time values must be entered in ascending order. Efficiencies must be non-
negative and no greater than 100.

Access: On the Pathways form, choose the Filter mechanism. On the Filter tabbed
folder, click Edit Efficiencies to pop up this form.

1.2.14 
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Data Entry for Transfer Mechanisms: Air Leakage

Air Leakage Rates
Acceptance case Test21 is illustrated here. Input values are leakage rates in units of
percent of volume (from which air leaks) per day.

Edits: Time values must be entered in ascending order. Leakage rates must be non-
negative.

Access: On the Pathways form, choose the Air Leakage mechanism.  On the Air
Leakage tabbed folder, click Edit Rates to pop up this form.

1.2.15 
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Data Entry for Transfer Mechanisms: Suppression Pool

Edit Selected Models
There are no acceptance cases that use this model. Input values are flow rate in cubic
feet per minute and decontamination factors, which are dimensionless.

Edits: Time values must be entered in ascending order. Decontamination Factors must
be greater than or equal to 1.

Access:  On the Pathways form, choose the Suppression Pool mechanism.  On the
Suppression Pool tabbed folder, check the models for which you want to enter data.
Click Edit Selected Models to pop up this form. In this case the user selected all three
models, i.e., Aerosol, Elemental I, and Organic I.
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2. RADTRAD Input File

2.1 Saving the Input File

After the input to the main form has been entered via the Compartment, Pathway, Dose
Location, and Source Term forms, the user should save a RADTRAD input file. There
are several ways to perform the save. Each of the actions in this table saves input or
leads to saving input.

From the File menu, select Save Radtrad input

Click the diskette icon on the toolbar

Check any Done checkbox to be prompted to save input

Right-click in the main form margin and select the Save inputs menu item

Click the Compute button to be prompted to save input

Click File->Exit to exit the program to be prompted to save input

Saving input is a critical step. When the user clicks Calculate to run RADTRAD, the
data that are visible on the forms are not used. Instead, the RADTRAD calculation
reads the contents of the filename shown on the main-form upper status bar near the
bottom of the frame. The lower status bar shows the name of the file to which
RADTRAD output will be written.

The RADTRAD input file name is filename.psf. Long filenames may be used. The
maximum length of any filename in RADTRAD, including drive letter:\path\filename, is
256 characters. Use of a remote file on a mapped network drive should work as long as
the full path is specified.  This applies to input, output, or reference files such as nuclide
inventory and dose conversion files.

2.2 Commenting the Input File

Comments may be added on lines designated “plain text” or after numerically formatted
data items. Adding comments on lines that contain filenames will cause RADTRAD to
crash.  The text editor accessed from the Read Output and Print button or File menu
item can be used to put comments on existing lines of an input file. Other text editors,
such as Notepad or Wordpad, can also be used.

There is no provision for adding more comment lines to the file than can be
accommodated by these inline methods. Adding additional lines to the input file will
cause RADTRAD to crash.
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2.3 Input File Format

In the table of variables below, the second column lists an abbreviation of the relevant
form name for each user-specified variable. The key to the abbreviations follows here.

Key to Form Column

CO Compartments form

TP Transfer Pathways form

DL Dose Locations form

ST Source Term form

CL Calculation Control Options form

If a form abbreviation is not noted next to a variable name or heading, the user is not
responsible for the input. For CO and TP tabular input, the popup data forms shown
above are created as needed. DL, ST, and CL forms do not use popup forms.

The Plant Model Section of the RADTRAD Input File
Plain text or variable name Form Format Comments
Plant Model Name: 1x, a19

plant_model_name CL a40 printable ASCII characters

Nuclide Inventory File: 1x, a21

inventory_filename ST a256 file name extension must be .nif; use
of full path is recommended

Plant Power Level: 1x, a20

plant_power_level ST f11.4 units = megawatts thermal
valid range  > 0.0

Compartments: 1x, a25

number_of_compartments i2 valid range = 0 to 10 inclusive

The following input format is used for each compartment.

Compartment N: 1x, a12, i3,a1 This line is not used.

compartment_name(N) CO a40 printable ASCII characters

compartment_type(N) CO 1x,i1 1 = control room,
2 = environment,
3 = other
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compartment_volume(N)CO 1x, e12.4 units = meter3
valid range  > 0.0

compartment_sprays(N)CO 1x, i1 0 = no sprays
1 = sprays present

compartment_sump(N) 1x, i1 0 = sump not present

compartment_filters(N) CO 1x, i1 0 = no recirculating filters
1 = recirculating filters present

compartment_deposition(N) CO 1x, i1 0 = no natural deposition
1 = natural deposition

compartment_opool(n) CO 1X,i1 0 = no overlying pool
1 = overlying pool

Repeat the above section of input for each compartment used.

Pathways: 1x, a9

number_of_pathways i2 valid range = 0 to 25 inclusive.

The following input format is used for each compartment-to-compartment pathway.

Pathway N: 1x, a9,i2,a4

pathway_name(N) TP a40 printable ASCII characters

pathway_from(N) TP i2 valid range = 1 to
number_of_compartments inclusive

pathway_to(N) TP i2 valid range = 1 to
number_of_compartments inclusive

pathway_type(N) TP i1 1 = piping
2 = filtered pathway
3 = suppression pool
4 = air leakage

Repeat the above section of input for each pathway used.
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The Scenario Description Section of the RADTRAD Input File

Formerly this section was a second input file. It is now concatenated with the plant file
with no changes to the line format except for the version 3.01 multiple-source input.

Plain text or variable name Form Format Comments
Scenario Description Name: 1x, a26

scenario_name CL 1x, a40 printable ASCII characters

Plant Model File Name: 1x, a21

plant_filename 1x, a40 not used; carriage return needed

Source Term: 1x, a12

Number_of_sources 1x, i3 Number of data lines to follow. M =
count.

Compartment_number CO (1x,i3,

sourceterm_fraction (1-M) CO 1x,e12.4) These two are on one line, with M
lines.

dose_conversion_filename ST 1x, a256 Filename extension must be INP. Use
of full path is recommended.

release_filename ST 1x, a256 Filename extension must be RFT. Use
of full path is recommended.

delay_time ST 1x, e12.4 valid range = > 0.0 hours

calculate_daughters ST 1x, i3 0 = no daughters are calculated
1 = all daughters are calculated

i_fraction_aerosol ST 4(1x,e12.4) valid range = 0.0 to 1.0
i_fraction_elemental ST valid range = 0.0 to 1.0
i_fraction_organic ST valid range = 0.0 to 1.0

These three variables must total 1.0
i_fraction_radioactive valid range = 0.0 to 1.0

These four variables are on one line.

Overlying Pool: 1x, a15

op_decay ST 1x, i3 0 = no decay chain processing
1 = decay chain processing

op_initial_volume CO 1x, e12.4 units = cubic meters
valid range > = 0.0

op_aerosol_model CO 1x, i3 0 = no aerosol removal
1 = user-specified decontamination
factors
2 = decontamination factors calculated
using the Powers model
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Overlying Pool: Aerosol: User-defined decontamination factors

The next two lines are included only if the user-specified decontamination factors are used
(op_aerosol_model = 1).

op_aerosol_count 1x, i3 valid range = 1 to 10 inclusive. M =
count.

op_aerosol_time(1-M) CO 2(1x, units = hours
op_aerosol_df(1-M) CO e12.4) valid range = 0.0 to 1.0

These two are on one line, with M
lines.

End of user-specified decontamination factors.

Overlying Pool: Aerosol: Powers model

The next three lines are included only if the Powers model for calculating the decontamination factors is
used (op_aerosol_model = 2.).

op_aerosol_percentile CO 1x, e12.4 10.0 = 10th percentile model
50.0 = 50th percentile model
90.0 = 90th percentile model

op_aerosol_count 1x, i3 valid range = 1 to 10 inclusive. M =
count.

op_aerosol_time(1-M) CO units = hours
op_aerosol_height(1-M) CO units = meters
op_aerosol_cooling(1-M) CO 3(1x, e12.4) units = K

These three are on one line, with M
lines.

End of Powers model-calculated decontamination factors.

Overlying Pool: Elemental Iodine: User-defined decontamination factors

op_elemental_model CO 1x, i3 0 = no elemental iodine removal
1 = user-specified decontamination
factors

These lines are included only if user-specified decontamination factors are used (op_elemental_model =
1).

op_elemental_count 1x, i3 1-10 = number of decontamination
factors.         M = count.

op_elemental_time(1-M) CO units = hours
op_elemental_df(1-M) CO 2(1x, e12.4) valid range = 0.0 to 1.0

These two are on one line, with M
lines.

End of user-specified decontamination factors.
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Overlying Pool: Organic Iodine: User-defined decontamination factors

op_organic_model CO 1x, i3 0 = no organic iodine removal
1 = user-specified decontamination
factors

These lines are included only if user-specified decontamination factors are used
(op_organic_model = 1).

op_organic_count 1x, i3 1-10 = number of decontamination
factors M=count.

op_organic_time(1-M) CO units = hours
op_organic_df(1-M) CO 2(1x, e12.4) valid range = 0.0 to 1.0

These two are on one line, with M
lines.

End of user-specified decontamination factors.

op_volatilization_model 1x, i3 0 = no iodine volatilization. Not used.
Placeholder zero is always present.

Compartments: 1x, a13

number_of_compartments 1x, i3 The number of compartments
specified in the plant  section of the
file.

Compartment n: 1x, a12,i3,a1 This line is not used.

compartment_detail(N) CO 1x, i3 0 = no detail output printed
1 = detail output printed

compartment_decay(N) ST 1x, i3 0 = no decay chain processing
1 = decay chain processing

Compartments: Sprays format

sprays_aerosol_model(N) CO 1x, i3 0 = no aerosol removal
1 = user-specified aerosol removal
coefficients
2 = aerosol removal coefficients
calculated using the Powers model

Sprays: Aerosol: User-defined removal coefficients

The next three lines are included if the user-specified removal coefficients are used
(sprays_aerosol_model(N) = 1).

Fresh_water_fraction e12.4 Not used. Placeholder required.

sprays_aerosol_count(N) 1x, i3 1-10 = number of aerosol removal
coefficients.
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M = this count. N = this compartment
number.

sprays_aerosol_time(N)(1-M) CO units = hours

sprays_aerosol(N)(1-M) CO 2(1x, e12.4) units = per second
These two are on one line with M
lines.

Sprays: Aerosol:  Powers model

The next five lines are included if the Powers model is used (sprays_aerosol_model(N)
= 2.).

Fresh_water_fraction 1x,e12.4 Not used. Placeholder required.

Sprays_aerosol_alpha CO 1x,e12.4 Fraction sprayed.

sprays_aerosol_percentile(N) CO 1x, e12.4 10.0 = 10th percentile model
50.0 = 50th percentile model
90.0 = 90th percentile model

sprays_aerosol_count(N) 1x, i3 1-10 = number of times for which flux
and height provided .

M = this count. N = this compartment
number.

sprays_aerosol_time(N)(1-M) CO units = hours
sprays_aerosol_flux(N)(1-M) CO units = cubic meters of water per

square meter per second
sprays_aerosol_height(N)(1-M) CO 3(1x, e12.4) units = meters

These three are on one line with M
lines.

End of Powers sprays model.

Sprays: Elemental Iodine: Removal coefficients

sprays_elemental_model(N) 1x, i3 0 = no elemental iodine removal;
1 = elemental iodine removal

The next three lines are present only if elemental I removal coefficients are used
(sprays_elemental_model(N) = 1).

Fresh_water_fraction 1x,e12.4 Not used. Placeholder required

sprays_elemental_count(N) 1x, i3 1-10 = number of removal
coefficients. 

M = this count. N = this compartment
number.

sprays_elemental_time(N)(1-M) CO units = hours
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sprays_elemental(N)(1-M) CO 2(1x, e12.4) valid range = 0.0 to 1.0
These two are on one line for M lines.

End of elemental iodine removal coefficients.

Sprays: Organic Iodine: Removal coefficients

sprays_organic_model(N) CO 1x, i3 0 = no organic iodine removal;
1 = organic iodine removal

The next three lines are present only if organic iodine removal coefficients are used
(sprays_organic_model(N)=1).

Fresh_water_fraction 1x,e12.4 Not used. Placeholder required

sprays_organic_count(N) 1x, i3 1-10 = number of removal coefficients.

M = this count. N = this compartment
number.

sprays_organic_time(N)(1-M) CO units = hours
sprays_organic(N)(1-M) CO 2(1x, e12.4) valid range = 0.0 to 1.0

These two are on one line, with M
lines.

End of organic iodine removal coefficients.

sump_volatilization_count(N) 1x, i3 0 = no iodine volatilization. Not used.
Placeholder required.

Compartments: Recirculating filter format

C_filter_eff_model(N) CO 1x, i3 0 = no filter action .
1 = filter action

The next three lines are included only if the recirculating filter feature is used
(C_filter_eff_model (N) = 1).

c_filter_norm_flow_rate(N) CO 1x, e12.4 units = per second

c_filter_eff_count(N) 1x, i3 1-10 = number of filter efficiencies.

M = this count. N = this compartment
number.

c_filter_aerosol_eff(N)(1-M) CO units = percent
valid range = 0.0 to 100.0 inclusive

c_filter_elemental_eff(N)(1-M) CO units = percent
valid range = 0.0 to 100.0 inclusive
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c_filter_organic_eff(N)(1-M) CO 3(1x, e12.4) units = percent
valid range = 0.0 to 100.0 inclusive.
These three are on one line, with M
lines.

Compartments: Natural deposition format

deposit_aerosol_model(N) CO 1x, i3 0 = model is not used
1 = user-specified aerosol removal
coefficients
2 = aerosol removal coefficients
calculated using the Henry model

3 = coefficients calculated using the
Powers deposition model.

Natural Deposition: Aerosol: User-specified decontamination factors.

The next two lines are included if the user-specified decontamination factors are used
(deposit_aerosol_model(N) = 1).

deposit_aerosol_count(N) CO 1x, i3 1-10 = number of aerosol removal
coefficients supplied or calculated

M = this count. N = this compartment
number.

deposit_aerosol_time(N)(1-M) CO units = hours
deposit_aerosol(N)(1-M) CO 2(1x, e12.4) units = per second

These two are on one line for M lines.

End of  user-specified aerosol decontamination factors.

Natural Deposition: Aerosol: Henry model

The next two lines is present only if the Henry model is used
(deposit_aerosol_model(N) = 2).

deposit_aerosol_count(N) CO 1x, i3 1-10 = number of time for which
height, partial density provided.

M = this count. N = this compartment
number

deposit_aerosol_time(N)(1-M) CO units = hours
deposit_height(N)(1-M) CO 3(1x, e12.4) units = meters

deposit_part_density(N)(1-M) CO units = grams/cc
These three are on one line for M
lines.
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End of the Henry deposition model.

Natural Deposition: Aerosol: Powers model

The next two lines is present only if the Powers deposition model is used
(deposit_aerosol _model(N) = 3).

deposit_aerosol_reactor CO 1x,i3 1=PWR-DBA; 2=PWR-SA;
3=BWR-DBA; 4=BWR-SA
5=APWR-DBA

deposit_aerosol_percentile CO 1x, e12.4 10.0 = 10th percentile
model
50.0 = 50th percentile model
90.0 = 90th percentile model.

End of Powers deposition model.

Natural Deposition: Elemental I: Removal coefficients

deposit_elemental_model(N) CO 1x, i3 0 = no elemental iodine removal.
1 = elemental iodine removal

The next two lines are present only if there is elemental iodine removal
(deposit_elemental_model(N) = 1).

deposit_elemental_count(N) CO 1x, i3 1-10 = number of elemental iodine
removal coefficients.

M = this count. N = this compartment
number

deposit_elemental_time(N)(1-M) CO units = hours
deposit_elemental(N)(1-M) CO 2(1x, e12.4) units = per second

These two are on one line for M lines.

Pathways: 1x, a9

number_of_pathways 1x, i3 valid range = the number of pathways
specified in the plant section of the file

Pathway n: 1x, a10,1x,i2       N=this pathway number

pathway_detail(N) 1x, i3 Not used. Placeholder required.

pathway_decay(N) 1x, i3 Not used. Placeholder required.

Piping Format

piping_aerosol_model(N) TP 1x, i3 valid range = 0 to 1 inclusive
0 = no aerosol removal
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1 = user-specified decontamination
factors
2 = Brockmann-Bixler model.

Piping: User-defined decontamination factors

The next two lines are included only if the user-specified decontamination factors are
used (piping_aerosol_model = 1).

piping_aerosol_count(N) 1x, i3 valid range = 1 to 10 inclusive

M= this count. N= this pathway.

piping_aerosol_time(N)(1-M) TP units = hours
piping_aerosol_df(N)(1-M) TP its = per second
piping_aerosol_flow(N)(1-M) TP 3(1x, e12.4) units = cubic meters per second

These three are on one line for M
lines.

End of user-defined decontamination factors.

Piping: Brockmann-Bixler model

The next five lines are included only if the Brockmann-Bixler model is used
(piping_aerosol_ model = 2).

piping_aerosol_count(N) 1x, i3 Valid range = 1-10 times for which
model data is provided.

M= this count. N= this pathway.

Brock_surface(N) TP 1x, e12.4 units = sq ft
Brock_volume(N) TP 1x, e12.4 units = cu ft
Brock_angle(N) TP 1x, e12.4 units = degrees
brock_time(N)(1-M) TP 4(1x, e12.4) units = hours
brock_flow(N)(1-M) TP units = cubic meters per second
brock_pressure(N)(1-M) TP units = atmospheres

brock_temp(N)(1-M) TP units =  degrees F. These four are on
one line for M lines.

End of Brockmann-Bixler model.

Piping: Elemental I: User-defined decontamination factors

piping_elemental_model(1) TP 1x, i3 0 = no elemental iodine removal
1 = user-specified elemental iodine
decontamination factors

The next two lines are included only if the user-specified decontamination factors are
used (piping_elemental_model = 1).

piping_elemental_count(N) TP 1x, i3 valid range = 1 to 10 inclusive

M= this count. N = this pathway.
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piping_elemental_time(N)(1-M) TP 3(1x, e12.4) units = hours
piping_elemental_df(N)(1-M) TP units = per second
piping_elemental_flow(N)(1-M) TP units = cubic meters per second

These three are on one line for M
lines.

End of Elemental I user-specified decontamination factors.

Piping: Organic I: User-defined decontamination factors

piping_organic_model(N) TP 1x, i3 0 = no aerosol removal
1 = user-specified aerosol
decontamination factors

These lines will be included if and only if the user-specified  decontamination factors
are used (piping_organic_model = 1).

piping_organic_count(N) 1x, i3 valid range = 1 to 25 inclusive

piping_organic_time(N)(1-M) TP 3(1x, e12.4) units = hours
piping_organic_df(N)(1-M) TP units = per second
piping_organic_flow(N)(1-M) TP units = cubic meters per second

These three are on one line for M
lines.

Filter format

p_filter_eff_model(N) TP 1x, i3 0 = no filter action.
1= filter action.

The next three lines are included only if p_filter_eff_model(N) = 1.

p_filter_eff_count(N) 1x, i3 valid range = 1 to 10 inclusive
1-10 = number of filter efficiencies.

M = this count. N = this pathway.

p_filter_norm_time(N)(1-M) TP 5(1x, e12.4) units = hours

p_filter_norm_flow_rate(N) TP units = per second

p_filter_aerosol_eff(N)(1-M) TP for all efficiencies  units = percent and
valid range = 0.0 to 100.0

p_filter_elemental_eff(N)(1-M) TP
p_filter_organic_eff(N)(1-M) TP These five variables are on one line

for M lines.

Suppression pool format: Aerosol: Decontamination factors

sp_aerosol_model(N) TP 1x, i3 0 = no aerosol removal
1 = user-specified decontamination
factors

The next three lines are included only if the user-specified decontamination factors are
used (sp_aerosol_model(N) = 1).
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sp_initial_volume(N) TP 1x, e12.4 units = cubic meters
valid range > 0.0
0.0 = no suppression pool

sp_aerosol_count(N) 1x, i3 valid range = 1 to 10

sp_aerosol_time(N)(1-M) TP units = hours

sp_aerosol_df(N)(1-M) TP 2(1x, e12.4) valid range = 0.0 to 1.0
These two variables are on one line
for M lines.

Suppression pool format: Elemental I: Decontamination factors

sp_elemental_model(N) TP 1x, i3 0 = no elemental iodine removal
1 = user-specified decontamination
factors

The next two lines are present only if user-specified decontamination factors are used
(sp_elemental_model(N) = 1).
sp_elemental_count(N) 1x, i3 valid range = 1 to 10. M = this count. N

= this pathway.

sp_elemental_time(N)(1-M) TP units = hours
sp_elemental_df(N)(1-M) TP 2(1x, e12.4) valid range = 0.0 to 1.0

These two variables are on one line
for M lines.

Suppression pool format: Organic I: Decontamination factors

sp_organic_model(N) TP 1x, i3 0 = no organic iodine removal
1 = user-specified decontamination
factors

The next two lines are included only if user-specified decontamination factors are used
(sp_organic_model(N) = 1).

sp_organic_count(N) 1x, i3 1-10 = number of decontamination
factors.

M = this count. N = this pathway.

sp_organic_time(N)(1-M) TP units = hours
sp_organic_df(N)(1-M) TP 2(1x, e12.4) valid range = 0.0 to 1.0

These two variables are on one line
for M lines.

sp_volatilization_model(N ) 1x, i3 0 = no iodine volatilization. Not used.
Placeholder value required.
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Air leakage format

convection_model(N) TP 1x, i3 0 = no natural convection
1 = user-specified normalized flow
rates

The next two lines are included only if the user-specified decontamination factors are
used (convection_model(N) = 1).

convection_count(N) 1x, i3 M = this count. N = this pathway. Valid
range = 1 to 10 .

convection_norm_flow(N)(1-M) TP 1x, e12.4 units = per second

water_leakage_model(1) 1x, i3 0 = no water leakage. Not used.
Placeholder value is required.

Dose Locations: 1x, a15

number_of_locations 1x, i3 valid range = 0 to 10

Location L: 1x, a11

location_name(L) DL 1x, a40 valid range = printable ASCII char(32)
to char(126) inclusive

compartment_number(L) DL 1x, i3 valid range = 1 to n inclusive
the number of the compartment that
the location is in.

Chi/Q format
location_xq_model(L) 1x, i3 0 = Χ/Q is a constant 1.0

1 = user-specified Χ/Q. Valid only for
compartments other than control
room.

The next two lines are included only if location_xq_model(L) = 1.

location_xq_count(L) 1x, i3 Number of times for which input is
provided. Valid range = 1-10. M =
count.

Location_xq_time(L)(1-M) DL (1x, i3 units = hours

Location_xq(L)(1-M) DL 1x, e12.4) units = seconds/ cu m. These two
variable are on one line for M lines.

Breathing rate format

Location_breathing_rate_model DL 1x,i3 0 = no breathing rate input

1 = breathing rate input

The next two lines are included only if location_breathing_rate_model(L) = 1.
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location_br_count(L) 1x, i3 Number of times for which input is
provided. Valid range = 1-10. M =
count.

Location_br_time(L)(1-M)DL (1x, i3 units = hours

Location_breathing_rate(L)(1-M) DL 1x, e12.4) units = cu m /second. These two
variable are on one line for M lines.

Occupancy factor format

Location_occupancy_model DL 1x,i3 0 = no occupancy factor input

1 = occupancy factor input . Valid only
for control-room compartment type 1.

The next two lines are included only if location_occupancy_model(L) = 1.

location_occupancy_count(L) 1x, i3 Number of times for which input is
provided. Valid range = 1-10. M =
count.

Location_occupy_time(L)(1-M) DL (1x, i3 units = hours

Location_occupy_factor(L)(1-M) DL 1x, e12.4) unitless.   These two variables are on
one line for M lines.

Repeat from “Location L:” for all dose locations.

Effective Volume Location: 1x, a26
Eff_vol_xq_model DL 1x,i3 0 = no effective volume input

1 = effective volume input . Control-
room X/Q is input here.

The next two lines are included only if eff_vol_xq_model =1.

Eff_vol_xq _count(L) 1x, i3 Number of times for which input is
provided. Valid range = 1-10. M =
count.

Eff_vol_xq _time(L)(1-M) DL (1x, i3, units = hours

Eff_vol_xq (L)(1-M) DL 1x, e12.4) unitless.   These two variables are on
one line for M lines.

Simulation Parameters: 1x, a22 Plain text line is not used.

Dt_max_count 1x,i3 Number of times for which
supplemental time steps are provided.
Valid range = 0 to 10. M = count.

The next line is present only if M is greater than zero.

Dt_max_time(1-M)              CL    2(1x, e12.4) Units = hours.
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Dt_max CL Units = hours. Maximum
time step. These two are on one line
for M lines.

Output Filename: 1x,a16 Plain text line is not used.

Output_filename CL 1x,a256 Name of output file. Use of full path is
recommended.

Show_plant CL 1x,i3 Include plant model.

Show_scenario CL 1x,i3 Include scenario description.

Show_event CL 1x,i3 Show results for every simulation
event.

Show_step CL 1x,i3 Show results for every supplemental
time step.

Show_model CL 1x,i3 Include runtime model information.

End of Scenario File    1x, a32
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3. Numerical Algorithms Used in Version 3.01

This section addresses the mathematical solution method used to ultimately calculate
the doses at various locations. The overall numerical solution technique is discussed in
Section 3.1. The numerical engine used to solve coupled sets of linear ordinary
differential equations is discussed in Section 3.2.

3.1 Numerical Solution Technique

It is possible to define a single system of coupled ordinary differential equations that
simultaneously represents all of the phenomena considered by the code. However, the
size of this equation set and the computational cost of its numerical solution would
make such an implementation impractical on a PC. Significant economies of calculation
time and computer memory size in RADTRAD are achieved by dividing the calculations
into two parts: (1) radioactive decay and daughter in-growth and (2) radionuclide
transport.

The fundamental premise behind this approach is that during a time step of small
enough duration the interdependence of the two components of a calculation can be
neglected. That is, the transport equations defining transfer of material between
compartments during a time step can be solved numerically without taking account of
the radioactive decay and in-growth occurring over that period. Likewise, the radioactive
decay and in-growth equations can be solved during a time step without considering the
simultaneous phenomenon of transport between compartments.  The user can test the
sensitivity of the calculated results by running the code with 0.25 hr, 1.0 hr, 4.0 hr, and
the default time steps to verify that the predicted results converge as time-step size
diminishes. In calculations where radioactive decay is not enabled, there is no
approximation associated with decoupling of the two physical processes.

The two types of calculations are performed alternately. That is, the code begins its
integration over a time step by analyzing the effect of radioactive decay and daughter
in-growth on the inventory of all compartments. After this, the code calculates the effect
of radionuclide transport between compartments during that same time step. This
process of alternating between radioactive decay and daughter in-growth and
radionuclide transport continues until the specified end time is reached. In calculations
where radioactive decay is not modeled, the solution algorithm is simplified to the single
step of calculating radionuclide transport.

During the course of its numerical integration, the code keeps track of the quantity of
each nuclide at each location. Locations include not only compartment volumes, but
surfaces, pools, and filters as well. By tracking the radionuclides in this manner,
conservation of mass can be verified.
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3.2 Transport Calculations

The present application is known as an initial value problem for the solution of ODEs.
Because of the assumptions used in RADTRAD, the ODEs are coupled but linear with
constant coefficients. Numerical solution of the transport equations is accomplished
with an algorithm taken from the ASH code, which was developed at Los Alamos
National Laboratory. This algorithm is essentially identical to the one described by
Birchall and James (1989). The solution is constructed as a Taylor series expansion;
the series is truncated when the estimated relative error is less than 10-8.

One advantage of this approach is its capacity to treat large time intervals. The key
assumption is that there is no change in any phenomenon during a time step, i.e., that
the coefficients in the ODEs are constant. Without this assumption, the ASH method
would not apply. In order to accommodate this assumption, the code synchronizes time
steps with the user-supplied phenomena in order to capture changes in the coefficients.
Other advantages of this approach are that it is very fast and extremely robust.
Provided that there are no active models that effectively cause the coefficients in the
ODEs to be nonconstant, such as radioactive decay and daughter in-growth, or the
Powers model for containment sprays, the computed results are nearly independent of
the number of time steps taken. Automatic time-step selection has been implemented
in the routines NECSTEP and AUTODT to ensure that the effects of nonconstant
coefficients are captured.  Automatic time-step selection is most important when the
Powers models for aerosol removal by sprays or in suppression pools are active.
Daughter in-growth also requires control over time-step size to achieve accurate results.
The user can also supply supplemental time steps on the Control Options screen,
which allows the user to verify that results are insensitive to further decreases in time-
step size.
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4. RADTRAD Acceptance Test Cases

4.1 Introduction

Some of the acceptance test results have changed slightly since the original publication
of the RADTRAD user’s manual (Humphreys et al., 1998). The changes are mainly due
to the replacement of the original numerical algorithm used to solve the system of
ordinary differential equations. In other words, differences in results obtained with
RADTRAD versions 2.2x and 3.01 are mainly numerical in nature and reflect
improvements in the underlying numerical programming. While these differences are
slight, it is useful to update the tables given in the previous manual with the ones that
are now obtained with version 3.01.

One new test case has been added to the set of cases included in the previous
document. This is named Test1a. This case was added in order to check the accuracy
of results for modeling a control room compartment, which is unique in that it is the only
compartment type that can have an inflow from the environment. RADTRAD version
2.2x did not correctly model control room concentrations and doses in some cases, so it
was decided to add this case as an additional check on the new version.

4.2 Summary of Test Case Results

Results for the standard suite of test problems are summarized in Tables 4.1 through
4.5. These tables are replacements for Tables 3.3.1.2-1 through 3.3.1.2-5 in the original
RADTRAD user’s manual. Tables 4.1 through 4.5 are updated to be consistent with the
results predicted by version 3.01. They also include results for the new test case,
Test1a.
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Table 4.1  PWR--Control room and natural deposition tests

Exclusion Low Population Control Room
Area Boundary Zone Control Room Activity

Test Case CODE Doses (rem) Doses (rem) Doses (rem) (curie)
TID-14844 Thyroid TEDE Thyroid TEDE Thyroid TEDE 131I 135Xe

1 RADTRAD 444 13.6 2990 91.9
HABIT 443 13.6 2990 91.9

2 RADTRAD 653 28.8 4400 220
HABIT 652 28.8 4400 220

3 RADTRAD 652 28.8 4400 220 2660 95.5 3.95E-03 0.75
HABIT 653 28.8 4400 220 2650 95.1 4.00E-03

4 RADTRAD 1130 47.5 809 66.9 4950 169 7.32E-03 0.75
HABIT 1130 47.6 808 66.8 4920 168 7.42E-03

5 RADTRAD 1300 54.1 8470 392 5300 180 7.87E-03 .75
NUREG-1465/PWR

6 RADTRAD 354 10.8 4905 151
HABIT 354 10.8 4905 151

7 RADTRAD 518 25.3 7200 382
HABIT 518 25.3 7200 382

8 RADTRAD 518 25.3 7200 382 481 25.7 7.31E-04 0.15
HABIT 518 25.3 7200 382 479 25.6

9 RADTRAD 477 23.4 707 54.4 179 12.7 2.52E-04 0.15
HABIT 477 23.4 707 54.3 178 12.6 2.55E-04

10 RADTRAD 509 24.9 829 60.4 184.8 12.9 2.52E-04 0.15
10A RADTRAD 471 23.1 690 53.6 179 12.7 2.52E-04 0.15
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Table 4.2 BWR--Control room and pipe deposition tests

Exclusion Low Population Control Room
Area Boundary Zone Control Room Activity

Test Case CODE Doses (rem) Doses (rem) Doses (rem) (curie)
TID-14844 (131I only) Thyroid TEDE Thyroid TEDE Thyroid TEDE 131I 135Xe

11 RADTRAD 6.25 0.192 2050 63.1
HABIT 6.26 0.192 2050 63.1

12 RADTRAD 6.25 0.192 2050 63.1 279 8.49 3.40E-03
HABIT 6.26 0.192 2050 63.1 277 8.44 3.40E-03

13 RADTRAD 0.284 0.0087 147 4.52 376 11.5 4.92E-03
HABIT 0.277 0.0085 145 4.45 372 11.3 4.86E-03

14 RADTRAD 0.119 0.004 39 1.20 97.5 3.0 1.19E-03
NUREG-1465/BWR (131I only)

13B RADTRAD
HABIT

0.0175
0.0151

5.35E-04
4.60E-04

87.1
86.5

2.67
2.60

213
211

6.48
6.44

2.99E-03

14B RADTRAD 0.0040 1.22E-04 4.59 0.141 4.66 0.142 5.72E-05
15 RADTRAD

HABIT
3.41
3.41

0.105
0.104

82.2
82.2

2.53
2.53

16 RADTRAD 3.41 0.105 82.2 2.53 44.7 1.36 1.54E-04
HABIT 3.41 0.105 82.2 2.53 44.2 1.35 1.56E-04
HABIT 3.41 0.104 82.2 2.53
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Table 4.3  PWR--Natural deposition and sprays tests

Exclusion Low Population Control Room
Area Boundary Zone Control Room Activity

Test Case CODE Doses (rem) Doses (rem) Doses (rem) Curie
NUREG-1465/PWR Thyroid TEDE Thyroid TEDE Thyroid TEDE 131I 135Xe

19 RADTRAD 314 9.62 3485 107
HABIT 315 9.66 3480 107

20 RADTRAD 459 22.7 5070 342
HABIT 460 22.7 5070 342

21 RADTRAD 459 22.7 5070 342 670 59.8 1.44E-03 0.988
HABIT 460 22.7 5070 342 669 59.7 1.51E-03

22 RADTRAD 424 21.1 1840 179 438 49.9 9.42E-04 0.987
HABIT 425 21.1 1840 179 436 49.7 9.73E-04

23 RADTRAD 61.7 4.16 58.1 106 14.1 36.2 2.83E-05 0.987
HABIT 61.7 4.16 58.1 106 14.0 36 2.92E-05

24 RADTRAD 68.6 4.54 58.4 106 14.1 36.2 2.83E-05 0.987
24A RADTRAD 68.6 4.54 58.4 106 14.1 36.2 2.83E-05 0.987
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Table 4.4  PWR and BWR decay and daughtering tests

Exclusion Low Population
Area Boundary Zone Containment Activity

Test Case Code Dose (rem) Dose (rem) (Curie)
TID-14844 Thyroid TEDE Thyroid TEDE 131I 135Xe 131Xe

1 RADTRAD 444 13.6 2990 91.9 1.14E+07
HABIT 443 13.6 2990 91.9 1.14E+07

2 RADTRAD 653 28.8 4400 220 1.14E+07 9.37E+07 4.64E+05
HABIT 652 28.8 4400 220 1.14E+07 9.37E+07 4.64E+05

2A RADTRAD 641 26.3 1620 53.0 8.61E+05 0 8.08E+04
HABIT 640 26.2 1610 52.6 8.60E+05 0 8.81E+04

2B RADTRAD 641 26.3 1620 53.0 8.61E+05 0 8.08E+05
NUREG-1465/PWR 131I 135Xe 137Cs

6 RADTRAD 354 10.8 4905 151 1.89E+07
HABIT 354 10.8 4905 151

7 RADTRAD 518 25.3 7200 382 1.89E+07 1.88E+07
HABIT 518 25.3 7200 382

7A RADTRAD 506 23.5 2680 157 1.43E+06 0 1.07E+06
HABIT 505 23.4 2660 156

NUREG-1465/BWR
7B RADTRAD 378 20.2 5530 327 1.44E+07 2.40E+07 1.18E+06

HABIT 378 20.2 5530 326
7C RADTRAD 370 18.8 2060 147 1.09E+06 0 1.18E+06

HABIT 369 18.7 2040 147
NUREG-1465/PWR

7D RADTRAD 445 19.6 2510 150 1.38E+06
HABIT 444 19.5 2500 150 1.37E+06 0
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Table 4.5  Analytic solution tests

EXCLUSION AREA BOUNDARY LOW POPULATION ZONE Control Room
Thyroid Dose TEDE Dose Thyroid Dose TEDE Dose 131I Activity

CASE RADTRAD HABIT RADTRAD HABIT RADTRAD HABIT RADTRAD HABIT RADTRAD HABIT

1 TID 131I

No Decay 444 444 13.6 13.6 2990 2990 91.9 91.8
Analytic 443 13.6 2990 91.9

1a TID 131I

No Decay 0.01191

Analytic 0.01190

2 TID              Full Source

No Decay 653 653 28.8 28.8 4400 4400 220 220
Analytic 652 28.7 4400 220

6 PWR NUREG-1465
131I
No Decay 354 354 10.8 10.8 4905 4905 151 151
Draft 1465 (4 releases) 356.6 10.9 9078 278.8
Analytic (4 releases) 356.7 10.9 9078 278.8

7 NUREG-1465

No Decay 518 518 25.3 25.3 7200 7200 382 382
Draft 1465 (4 releases) 522.5 25.7 14190 976.6
Analytic (4 releases) 522.5 25.7 14190 976.6
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4.3 Acceptance Test Case 1a

Problem Description
PWR design (see Figure 2).
Instantaneous modified TID-14844 (131I only) release into containment.
Release begins at reactor shutdown.
No explicit calculation of removal mechanisms in the containment, but 50% of

the released iodine is deposited in accordance with TID-14844.
Containment leak to the environment.

PWR
Containment

Containment
Leakage

Control
Room

Control Room
Un-Filtered In Flow

Control Room
Exhaust

Source Term
Release fractions and timing: TID-14844, Table IV with modifications per

NRC Regulatory Guides 1.3 and 1.4  (removes mixed fission
products and details iodine fractions) and further modified as
described below.

Start of release: 0.0000 hr
Iodine fractions: Fraction of released iodine chemical form:

Elemental: 1.0000
Organic: 0.0000
Aerosol: 0.0000

Inventory: TID-14844 example normalized core inventory modified as
follows:

131I only
Reactor power: 1 MWth

Plant Model
Containment volume: 1.0000E+05  ft3

Environment
Containment leakage: Air leakage from: Containment to: Environment
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Scenario Description
Containment leak rate: 0.1000%/day

Dose Parameters
Control room values: Time (hr) X/Q (s/m3)

0.0000 0.3053E−01
720.00 0.0000E+00

Success Criteria
All of the RADTRAD-calculated 131I activities must equal the analytical results within
± 0.1%.

Acceptance Criteria
All of the success criteria must be met or exceeded in order for the RADTRAD
software to be acceptable to the NRC.

Results

Test Case 1 RADTRAD Analytic
Solution

Containment 131I (Ci) 11903 11903

Control Room 131I (Ci) 0.01191 0.01190
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